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DRIVER & SOFTWARE INSTALLATION

Before beginning, make sure your computer meets these system requirements:

PC:

Windows XP, Vista (32- or 64-bit), or 7 (32- or 64-bit)
Screen Resolution: 1024 x 768, 16-bit (or above)
Pentium 2 450 MHz (or comparable) or above

512 MB RAM (2GB or more recommended)

10 GB free hard drive space

Available USB 2.0 port (preferably on rear panel)
CD- or DVD-ROM drive

Optional: DVD burner

OS X 10.5.6 (or above)

1.5 GHz Intel Core Solo

1 GB 667 MHz DDR2 SDRAM

10 GB free hard drive space

Available USB 2.0 port (preferably on rear panel)
CD- or DVD-ROM drive

Optional: DVD burner

TWO CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL INTERFERENCE, AND (2) THIS DEVICE MUST
ACCEPT ANY INTERFERENCE RECEIVED, INCLUDING INTERFERENCE THAT MAY CAUSE UNDESIRED

m THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO THE FOLLOWING

OPERATION.



WINDOWS

1. Insert the CD into your computer's CD drive.
2. Install the drivers.

On the window that appears after you insert the CD, click "Install » Driver." Follow the on-screen
instructions that appear to complete the installation.
If this window does not automatically appear, double-click "My Computer" then double-click the CD.
The window should appear. (If the window still does not appear, right-click the CD and select
"Explore." Once the CD's contents are shown, double-click the "PC" folder, double-click the
"Driver" folder, then double-click "Setup.exe.")

3. Install the software.

On the window that appears after you insert the CD, click "Install » Software." Follow the on-
screen instructions that appear to complete the installation.

If this window does not automatically appear, double-click "My Computer" then double-click the CD.
The window should appear. If the window still does not appear, right-click the CD and select
"Explore." Once the CD's contents are shown, double-click the "PC" folder, double-click the
"Software" folder, double-click the "Cyberlink..." folder, then double-click "Setup.exe."

You can eject the CD and begin using VIDEO 2 PC and the software you installed.

4. Connect the device.
Connect VIDEO 2 PC to a free USB2.0 port on your computer. (We recommend connecting it to a
port on the rear panel of your computer.)
You may see several dialog boxes in the corner of the screen, indicating the computer has detected
VIDEO 2 PC is connected. In some cases, you may see a message resembling an error message —
this is normal. Click "OK" (if necessary).

5. Begin!
You can find the software by going to Start Menu »
All Programs » Cyberlink PowerProducer or
PowerDirector. (You may also double-click the
shortcut icon on your computer's Desktop.)
The first time you open PowerDirector, you will be
asked to enter a serial number. Find the number on the sleeve of the CD and enter it.

Note: Sometimes, the software will
ask if you want to upgrade after you
open it. This is optional but not
required.



MAC

1. Insert the CD into your computer's CD drive.

2, Install the drivers and software.
Double-click the CD on the Desktop. On the window that appears, double-click the "Mac" folder,
then double-click "EZCap EN.pkg." Follow the on-screen instructions that appear to complete the
installation. You will need to restart your computer afterward to complete this process.
You may now eject the CD.

3. Connect the device.
Connect VIDEO 2 PC to a free USB2.0 port on your computer. (We recommend connecting it to a
port on the rear panel of your computer.)

4. Begin!
You can find the software by going to Applications » EzCAP » EzCAP. The first time you open
EzCAP, you will be asked to enter a serial number into the "Serial Number" field. Find the number
on the sleeve of the EzZCAP CD and enter it then click "OK."
After installing EzCAP, you can also use VIDEO 2 PC in any program that uses QuickTime video
digitizers, such as Apple QuickTime Player.



VIDEO PLAYBACK DEVICE
COMPUTER

IMPORTANT:

To capture a video's sound, connect the left and right AUDIO INPUTS to the left and right audio outputs of your
playback device.

To capture the video image itself, choose either the COMPOSITE VIDEO INPUT or the S-VIDEO INPUT.

1.

USB CONNECTOR - Connect this end of VIDEO 2 PC to the included USB extension cable then connect
the extension cable to an available USB 2.0 port on your computer (preferably a port on the rear panel).

AUDIO INPUTS - Use standard RCA cables to connect these left and right audio inputs to the left and
right audio outputs of your playback device. Be sure to match the colors properly — red to red, white to
white.

COMPOSITE VIDEO INPUT - Use a standard
composite video cable to connect this input to the
composite video output of your playback device. (If your
playback device has an S-Video output, you may
connect that to the S-VIDEO INPUT instead.)

S-VIDEO INPUT - Use a standard S-Video cable (not included) to connect this input to the S-Video output
of your playback device.

Note: Generally, S-Video connections are
of a better quality than composite video, so
we recommend using this one if your
playback device has an S-Video output.



PowerDirector (PC)

1.

Connect VIDEO 2 PC to your playback device and to your
computer (as shown in the OVERVIEW).

Note: Sometimes, the software will
ask if you want to upgrade after you

2. Open PowerDirector. You can find the software by going to open it. This is optional but not
Start Menu » All Programs » Cyberlink PowerDirector. repquired.. B
(You may also double-click the shortcut icon on your
computer's Desktop.)

3. Click the "Capture" tab in the upper left-hand corner of the Note: F toaket [ i
screen. The software will automatically detect your video (MR el MEO R IR
device about using PowerDirector, press F1

) ) o on your keyboard or click the

4. Start recording by clicking the red "Record" button. Play your “director's chair" icon button in the
video source (digital camera, TV, DVD player, etc.). upper left-hand corner of the screen,

5. When you are done capturing your video, click the "Stop" and go to "Help" then "PowerDirector
button. Help" to access the software's help

6. Enter the title of your video in the "Captured File Name" field | file-

in the window that appears and click "OK." The video will
appear in the "Captured Content" at the bottom of the window.

* |f you want to create a CD, click the "Create Disc" tab.
Use the buttons underneath the "Content" tab to add
the videos you want on your CD, then click "Burn" to
burn the disc.

e If you want to save a video in a popular format (such as
a portable MPEG-4 for PSP, iPod*, or iPhone*), click
the "Edit" tab then click the "Produce" tab and select
the proper format.

* Note: In some cases, depending on
your computer's operating system,
your video's picture or sound in
PowerDirector may appear "jerky" or
"stalled." This will not affect your
video, though; it is actually capturing it
properly.

e |f you want to upload a video to YouTube™ or Facebook™, click the "Edit" tab then click the
"Produce" tab then click the "YouTube" or "Facebook" tab near the top of the window.

iPhone and iPod are trademarks of Apple Inc., registered in the U.S. and other countries.
YouTube is a trademark of YouTube, LLC.
Facebook is a registered trademark of Facebook, Inc.



EzCAP Capture (Mac)

1.

Connect VIDEO 2 PC to your playback device and to your
computer (as shown in the OVERVIEW). VIDEO 2 PC must
be connected to your computer for the software to open
properly.

Open EzCAP Capture. You can find the software by going to
Applications » EzCAP » EzCAP.

The first time you open EzCAP, you will be asked to enter a
serial number. Find the number on the sleeve of the EzZCAP
CD and enter it.

* Note: In some cases, depending on
your computer's operating system,
your video's picture or sound in
EzCAP may appear ‘jerky" or
"stalled." This will not affect your
video, though; it is actually capturing it
properly. If this occurs, though, we
recommend using QuickTime for more
fluid video monitoring. See the
QuickTime instructions below for

details.
EzCAP Capture is now open. (Note: Do not play your video

source (digital camera, TV, DVD player, etc.) yet. You need to set the software's audio first.)

Click "Record" in the top menu and select "Sound Settings." In the window that appears, click the
"Source" tab and select "ION Audio USB 2861 Device" from the list below it. Also, make sure the menu
next to "Speaker" is set to "On." Click "OK" when you are done.

Start recording by clicking "Record" in the top menu and selecting "Record." * (You can also press
"Command" + "R.") Play your video source (digital camera, TV, DVD player, etc.).

When you are done capturing your video, click anywhere inside the box at the center of the screen. To
return to the main screen, click "OK."

For more information on using EzCAP Capture, please refer to the manual (PDF) in the "Mac" folder on the
included CD.

Important note!

To play your captured video on your iPod or iPhone, the video must be in a specific type of MPEG-4 format, even
if you already saved your video as an MPEG-4 in the software. To convert your video to be played on your device,
follow these steps:

1.

[
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Capture your video, save it, then close the software.

Open your Applications folder.

Open QuickTime, click the "File" menu and select "Open File."

Locate and the video you just captured and click "Open." The video will open in QuickTime.

Click the "File" menu and select "Save As." (You can rename the movie or save it to a new location, if
desired.)

Click the "Format" drop-down menu and select your device.
Click "Save." This file can now be played on your device.



QuickTime (Mac)

1.

2.

10.

1.

12.

Connect VIDEO 2 PC to your playback device and to your

. Note: If your Mac is running an older
computer (as shown in the OVEBVIEW). . . ©Sh (a9 10.4) yourtversionilof
In order to use VIDEO 2 PC with QuickTime, you must first QuickTime may not have the option to

register your EzZCAP Capture software. Open EzCAP Capture record and save movie files. If this is
by going to Applications » EzCAP » EzCAP. the case, we recommend upgrading to
You will be asked to enter a serial number into the "Serial QuickTime Pro to access these
Number" field. Find the number on the sleeve of the EzCAP features.

CD and enter it then click "OK."

After entering the serial number and EzCAP Capture opens successfully, you may close it.

If you are using Snow Leopard (Mac OS X 10.6), set QuickTime to open in 32-bit mode before beginning.
To do this, go to your Applications folder, right-click "QuickTime" and select "Get Info," check the "Open
in 32-bit mode" box in the window that appears, then close the window.

Open QuickTime, click the "File" menu and select "New Movie Recording."

If you see a downward-pointing triangle to the right of the "record" button, click it to open a drop-down
menu. If you do not see the triangle, click the "QuickTime Player" menu at the top of the screen and
select "Preferences."

In the drop-down menu, make sure that the proper "Camera" setting is selected ("Composite" or "S-
Video," depending on which connector you are using) and that "ION Audio USB 2861 Device" is selected
as the "Microphone." (Also, make sure the volume slider on the left-hand side of the window is turned up.)
Start recording by clicking the red "record" button at the bottom of the screen. Play your video source
(digital camera, TV, DVD player, etc.).

When you are done capturing your video, click the "stop" button. Your captured video will automatically
open in the QuickTime player. To save it, go to "File" and select "Save" (or "Save As" to save it with a
different name, but save it as a "self-contained" movie).

If you want the captured video to be playable on your iPhone or iPod, click the "Format" drop-down menu
and select your device: "iPhone (Cellular)," "iPhone," or "iPod."

Click "Save."



CONTENIDO DE LA CAJA

VIDEO 2 PC

Cable de audio/video RCA

CD de software

Guia de inicio rapido

Folleto de instrucciones de seguridad e informacion sobre la garantia

INS CION DEL DRIVER Y EL SOFTWARE

Antes de comenzar, asegurese de que su computadora cumpla estos requisitos de sistema:

PC:

Windows XP, Vista (32 o 64 bits) o 7 (32 o 64 bits)

Resolucién de pantalla: 1024 x 768, 16 bits (o superior)

Pentium 2 450 MHz (o comparable) o superior

512 MB de RAM (se recomienda 2GB o mas)

10 GB de espacio libre en disco duro

Puerto USB 2.0 disponible (preferentemente en el panel trasero)
Lectora de CD o DVD-ROM

Opcional: Quemador de DVD

OS X 10.5.6 (o superior)

Intel Core Solo de 1.5 GHz

SDRAM DE 1 GB 667 MHz DDR2

10 GB de espacio libre en disco duro

Puerto USB 2.0 disponible (preferentemente en el panel trasero)
Lectora de CD o DVD-ROM

Opcional: Quemador de DVD



WINDOWS

1. Inserte el CD en el lector de CD de la computadora.

2. Instale los drivers.
En la ventana que aparece después de insertar el CD, haga clic en "Install » Drivers." Siga las
instrucciones que aparecen en la pantalla para terminar la instalacion.
Si esta ventana no aparece automaticamente, haga doble clic en "My Computer" (Mi PC) y luego
en el CD. Debe aparecer la ventana. (Si la ventana sigue sin aparecer, haga doble clic en el CD y
seleccione "Explore" (Explorar)). Una vez que aparezca el contenido del CD, haga doble clic en la
carpeta "PC", en la carpeta "Driver" y finalmente en "Setup.exe.")

3. Instale el software.
En la ventana que aparece después de que insert6 el CD, haga clic en "Install » Software".Siga
las instrucciones que aparecen en la pantalla para terminar la instalacién.
Si esta ventana no aparece automaticamente, haga doble clic en "My Computer" (Mi PC) y luego
en el CD. Debe aparecer la ventana. (Si la ventana sigue sin aparecer, haga doble clic en el CD y
seleccione "Explore" (Explorar)). Una vez que aparezca el contenido del CD, haga doble clic en la
carpeta "PC", en la carpeta "Software", en la carpeta "Cyberlink..." y finalmente en "Setup.exe.")
Puede expulsar el CD y comenzar a usar VIDEO 2 PC y el software que instalé.

4. Conecte el dispositivo.
Conecte el VIDEO 2 PC a un puerto USB2.0 libre de la computadora. (Recomendamos conectarlo
a un puerto del panel trasero de la computadora.)
Es posible que vea varios cuadros de didlogo en la esquina de la pantalla, que le indican que la
computadora detecté que estd conectado el VIDEO 2 PC. En algunos casos, puede ver un
mensaje que parece de error — es normal. Haga clic en "OK" (Aceptar) (si fuera necesario).

5. jComience!
Puede encontrar el software yendo al menu Start
(Inicio) » All Programs (Todos los programas) »
Cyberlink PowerDirector. (También puede hacer
doble clic en el icono del acceso directo del escritorio
de la computadora.)
La primera vez que abra PowerDirector, se le solicitara que ingrese un niumero de serie. Busque el
numero en la funda del CD y ingréselo.

Nota: Algunas veces, el software le
preguntara si desea actualizarlo
después de abrirlo. Esto es opcional
pero no obligatorio.
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MAC

Inserte el CD en el lector de CD de la computadora.
Instale primero los drivers y el software

Haga doble clic en el CD del escritorio, en la carpeta "Mac" y en el archivo "EZCap ES.pkg". Siga
las instrucciones que aparecen en la pantalla para terminar la instalaciéon. Es necesario que reinicie
la computadora después de terminar el proceso.

Puede expulsar el CD.
Conecte el dispositivo.

Conecte el VIDEO 2 PC a un puerto USB2.0 libre de la computadora. (Recomendamos conectarlo
a un puerto del panel trasero de la computadora.)

jComience!
Puede encontrar el software yendo a Applications (Aplicaciones) » EzCAP » EzCAP Capture.

La primera vez que abra EzCAP, se le solicitard que ingrese un nimero de serie en el campo
"Serial Number". Busque el nimero en la funda del CD de EzCAP, ingréselo y haga clic en "OK."

Después de instalar EzZCAP, puede usar también VIDEO 2 PC en cualquier programa que use los
digitalizadores de video QuickTime, como Apple QuickTime Player.

11



COMPUTADORA

DISPOSITIVO DE
REPRODUCCION DE VIDEO

Televisor VCR

Camara
digital

...etc.

IMPORTANTE:

Para capturar el sonido de un video, conecte las ENTRADAS DE AUDIO izquierda y derecha a las salidas de
audio izquierda y derecha de su dispositivo de reproduccion.

Para capturar la imagen de video propiamente dicha, elija ya sea la ENTRADA DE VIDEO COMPUESTO ola
ENTRADA DE S-VIDEO.

1.

CONECTOR USB - Conecte este extremo del VIDEO 2 PC al cable de extensiéon USB incluido y luego
conecte dicho cable a un puerto USB 2.0 disponible de la computadora (preferiblemente un puerto del
panel trasero).

ENTRADAS DE AUDIO - Use cables RCA estandar para conectar estas entradas de audio izquierda y
derecha a las salidas de audio izquierda y derecha de su dispositivo de reproduccion. Asegurese de que
los colores coincidan correctamente —rojo con rojo y blanco con blanco.

ENTRADA DE VIDEO COMPUESTO - Use un cable de video compuesto estandar para conectar esta
entrada a la salida de video compuesto de su dispositivo de reproduccion. (Si el dispositivo de
reproduccion tiene una salida de S-Video, puede conectarla en cambio a la ENTRADA S-VIDEO.)

ENTRADA DE S-VIDEO - Use un cable de S-Video compuesto estandar (non incluido) para conectar esta
entrada a la salida de S-Video de su dispositivo de reproduccién. (Generalmente, las conexiones de S-
Video son de mejor calidad que las de video compuesto, de modo que recomendamos usarlas si el
dispositivo de reproduccion cuenta con una salida de S-Video.)

12



PARA COMENZAR

PowerDirector (PC)

1.

Conecte el VIDEO 2 PC al dispositivo de reproduccion y a la
computadora (como se muestra en la VISTA GENERAL).

Nota: Algunas veces, el software le
preguntard si desea actualizarlo

2. Abra PowerDirector. Puede encontrar el software yendo al 4 : p
. e rirlo. Esto onal
menu Start (Inicio) » All Programs (Todos los programas) » g:fgﬁisogﬁgi?olrio Sto es opciona
Cyberlink PowerDirector. (También puede hacer doble clic :
en el icono del acceso directo del escritorio de la
computadora.) Nota: Para obtener informaciéon mas
3. Haga clic en la pestafa “Capture" (Capturar) en la esquina detallada acerca del uso de
izquierda superior de la pantalla. El software detecta PowerDirector, pulse F1 en su teclado
automaticamente su dispositivo de video. o haga clic en el botén con el icono de
4. Comience a grabar haciendo clic en el botén rojo "Record”. | [a "silla del director” de la esquina
Reproduzca con su fuente de video (camara digital, televisor, | superior izquierda de la pantalla y
reproductor de DVD, etc.). vaya a "Help" y luego "PowerDirector
5. Cuando termine de capturar su video, haga clic en el boton Helz dpallra facceder al archivo de
"Stop" (Parar). ayuda del software.
6. Ingrese el titulo de su video en el campo "Captured File

Name" (Nombre del archivo capturado) de la ventana que
aparece y haga clic en "OK." El video aparece en “Captured
Content” (Contenido capturado) al pie de la ventana.

e Sidesea crear un CD, haga clic en la pestafia "Create
Disc". Use los botones que estan debajo de la pestana
"Content" para agregar a su CD los videos que desea
y luego haga clic en "Burn" para quemar el disco.

e Si desea guardar un video en un formato popular

*Nota: En algunos casos, segun sea
el sistema operatvo de su
computadora, la imagen de su video
en PowerDirector puede aparecer
"inestable" o "atascada". Esto no
afecta a su video, en realidad se esta
capturando correctamente.

(como MPEG-4 para PSP portatil, iPod™ o iPhone™), haga clic en la pestafia "Edit" (Editar) y
luego en la pestafa "Produce" (Producir) y seleccione el formato apropiado.
e Si desea subir un video a YouTube™ o Facebook™, haga clic en la pestafia "Edit" (Editar) y luego

en la pestaia "Produce" y luego en la pestaia "YouTube" o "Facebook" cerca de la parte
superior de la ventana.

*iTunes e iPod son marcas registradas de Apple, Inc., registradas en EE.UU. y otros paises.
YouTube es una marca registrada de YouTube, LLC.
Facebook es una marca registrada de Facebook, Inc.
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EzCAP Capture (Mac)

1.

Conecte el VIDEO 2 PC al dispositivo de reproduccién y a la
computadora (como se muestra en la VISTA GENERAL).
VIDEO 2 PC debe estar conectado a su computadora para
que el software se abra correctamente.

Abra EzCAP Capture. Puede encontrar el software yendo a
Applications » EzCAP » EzCAP (Aplicaciones > EzCAP >
EzCAP.

La primera vez que abra EzCAP, se le pedira que ingrese un
nimero de serie. Busque el niumero en la funda del CD de
EzCAP e ingréselo.

*Nota: En algunos casos, segln sea
el sistema operatvo de su
computadora, la imagen de su video
en EzCAP puede aparecer "inestable"
o "atascada". Esto no afecta a su
video, en realidad se esta capturando
correctamente.  Si esto ocurre, no
obstante, recomendamos usar
QuickTime para un monitoreo mas
fluido del video. Consulte los detalles

De esta forma, se abre EzCAP Capture. (Nota: No
reproduzca su fuente de video (camara digital, TV,
reproductor de DVD, etc.) todavia. (Debe configurar primero
el audio del software.)

Haga clic en "Record" (Grabar) en el menu superior y seleccione "Sound Settings" (Ajustes de sonido).
En la ventana que aparece,haga clic en la pestafia "Source" (Fuente) y seleccione "ION Audio USB 2861
Device" en la lista que estd abajo. Asimismo, asegurese de que el menu que esta junto a "Speaker"
(Altavoz) esta en "On" (Activado). Haga clic en "OK" (Aceptar) cuando termine.

Comience a grabar haciendo clic en "Record" (Grabar) en el menu superior y seleccionando "Record". *
(También puede pulsar “Command” + “R"). Reproduzca con su fuente de video (camara digital, televisor,
reproductor de DVD, etc.).

Cuando termine de capturar su video, haga clic en cualquier parte del cuadro del centro de la pantalla.
Para volver a la pantalla principal, haga clic en "OK".

Para mas informacién acerca del uso de EzCAP Capture, consulte el manual (PDF) en la carpeta "Mac"
del CD incluido.

mas abajo, en las instrucciones de
QuickTime.

iNota importante!

Para reproducir el video que capturé en su iPod o iPhone, el video debe estar en un formato especifico de
MPEG-4, incluso si ya lo guardé como MPEG-4 en el software. Para convertir su video a fin de reproducirlo en su
dispositivo, siga estos pasos:

1.

2.
3.
4
5

24

Capture su video, guérdelo y luego cierre el software.

Abra la carpeta Applications (Aplicaciones).

Abra QuickTime, haga clic en el menu "File" (Archivo) y seleccione "Open File" (Abrir archivo).
Localice el video que acaba de capturar y haga clic en"Open" (Abrir). El video se abrird en QuickTime.

Haga clic en el menu "File" (Archivo) y seleccione "Save As" (Guardar como). (Es posible cambiar el
nombre de la pelicula o guardarla en una ubicacion nueva, si lo desea.)

Haga clic en el menu desplegable "Format" (Formato) y seleccione su dispositivo.
Haga clic en "Save" (Guardar). Este archivo se puede reproducir ahora en su dispositivo.

14



QuickTime (Mac)

1.

2.

10.

1.

12

Conecte el VIDEO 2 PC al dispositivo de reproduccién y a la
computadora (como se muestra en la VISTA GENERAL).

Para usar VIDEO 2 PC con QuickTime, debe registrar primero
su software EzCAP Capture. Abra EzCAP Capture yendo a

Nota: Si en su Mac se esta
ejecutando un sistema operativo
antiguo (como el 10.4), su versién de
QuickTime puede no contar con la

Applications » EzCAP » EzCAP. opcién de grabar y guardar archivos
Se le solicitard que ingrese un nimero de serie en el campo de peliculas. En este caso,
"Serial Number". Busque el nimero en la funda del CD de recomendamos actualizarse a
EzCAP, ingréselo y haga clic en "OK." QuickTime Pro para acceder a estas

Después de ingresar el numero de serie y que EzCAP | funciones.

Capture se abra exitosamente, puede cerrarlo.

Si va a usar Snow Leopard (Mac OS X 10.6), configure QuickTime para abrirse en el modo de 32 bits
antes de comenzar. Para hacerlo, vaya a su carpeta Applications (Aplicaciones), haga doble clic en
"QuickTime" y seleccione "Get Info" (Obtener informacion), marque la casilla "Open in 32-bit mode"
(Abrir en modo de 32 bits) en la ventana que aparece y luego cierre la ventana.

Abra QuickTime, haga clic en el menu "File" y seleccione "New Movie Recording” (Grabacién de pelicula
nueva).

Si ve un tridngulo con la punta para abajo a la derecha del botén "grabar", haga clic en el mismo para abrir
un menu desplegable. Si no ve el tridngulo, haga clic en el menu "QuickTime Player" (Reproductor de
QuickTime) de la parte superior de la pantalla y seleccione "Preferences” (Preferencias).

En el menu desplegable, asegurese de que esté seleccionado el ajuste "Camera" (Camara) correcto
("Composite" (Compuesto) o "S-Video", segln el conector que esté usando) y que esté seleccionado
"USB 2861 Device" como "Microphone" (Micréfono). (Asimismo, asegurese de que el cursor de volumen
de la izquierda de la pantalla esté subido.)

Comience a grabar haciendo clic en el botén rojo "grabar" del pie de la pantalla. Reproduzca con su
fuente de video (camara digital, televisor, reproductor de DVD, etc.).

Cuando termine de capturar su video, haga clic en el botén "parar'. El video que capturd se abre
automaticamente en el reproductor de QuickTime. Para guardarlo, vaya a "File" y seleccione "Save"
(Guardar) (o "Save As" (Guardar como) para guardarlo con un nombre diferente, pero gudrdelo como
pelicula "autocontenida").

Si desea que el video capturado se pueda reproducir en un iPhone o iPod, haga clic en el menu
desplegable "Format" y seleccione su dispositivo: "iPhone (Celular)," "iPhone" o "iPod".

Haga clic en "Save.
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CONTENU DE LA BOITE

VIDEO 2 PC

Cable audio/vidéo RCA

CD logiciel

Guide d'utilisation simplifié

Consignes de sécurité et informations concernant la garantie

INSTALLATION DU LOGICIEL ET DES PILOTES

Avant de commencer, veuillez vous assurer que votre ordinateur dispose de la configuration systeme
requise suivante :

PC:

Windows XP, Vista (32 ou 64 bits), ou 7 (32 ou 64 bits)

Résolution de I'écran : 1024 x 768, 16 bits (ou supérieur)

Pentium 2 450 MHz (ou comparable) ou supérieur

512 Mo de mémoire vive (2 Go ou plus recommandé)

10 Go Mo d’'espace disque libre

Port USB 2.0 disponible (de préférence sur le panneau arriére de I'ordinateur)
Lecteur CD ou DVD

Facultatif : Graveur DVD

OS X 10.5.6 (ou supérieure)

1,5 GHz Intel Core Solo

1 Go 667 MHz DDR2 SDRAM

10 Go Mo d’espace disque libre

Port USB 2.0 disponible (de préférence sur le panneau arriére de I'ordinateur)
Lecteur CD ou DVD

Facultatif : Graveur DVD
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WINDOWS

3.

Insérez le CD-ROM dans le lecteur CD-ROM de votre ordinateur.
Installez les pilotes.

Sur la fenétre qui s’affiche une fois le CD-ROM inséré, cliquez sur « Install » Driver ». Suivez les
instructions a I'écran pour compléter l'installation.

Si aucune fenétre ne s'ouvre, double-cliquez sur « Poste de travail », puis double-cliquez sur le
CD-ROM. La fenétre devrait s’afficher. (Si la fenétre ne s'ouvre toujours pas, double-cliquez sur le
CD-ROM puis sélectionnez « Explorer ».) Une fois le contenu du CD-ROM affiché, double-cliquez
sur le dossier « PC», puis double-cliquez sur le dossier « Driver » et double-cliquez sur
« Setup.exe ».

Installez le logiciel.

Sur la fenétre qui s’affiche une fois le CD-ROM inséré, cliquez sur « Install » Software ». Suivez
les instructions a I'écran pour compléter I'installation.

Si aucune fenétre ne s'ouvre, double-cliquez sur « Poste de travail », puis double-cliquez sur le
CD-ROM. La fenétre devrait s’afficher. Si la fenétre ne s'ouvre toujours pas, double-cliquez sur le
CD-ROM puis sélectionnez « Explorer ». Une fois le contenu du CD-ROM affiché, double-cliquez
sur le dossier « Mac », puis double-cliquez sur le dossier « Software », puis double-cliquez sur le
dossier « Cyberlink... » et double-cliquez sur « Setup.exe ».

Vous pouvez éjecter le CD-ROM et utiliser le VIDEO 2 PC et le logiciel que vous avez installé.

Raccordez I'appareil.

Branchez le VIDEO 2 PC a un port USB 2.0 de votre ordinateur. (Nous vous recommandons de le
brancher a un port USB sur le panneau arriére de l'ordinateur.)

Il se peut que quelques boites de dialogue s'affichent indiquant que I'ordinateur a détecté le VIDEO
2 PC. Dans certains cas, il se peut qu'un message d’erreur s’affiche — ceci est normal. Cliquez
« OK » si cela est requis.

Vous pouvez maintenant utiliser le VIDEO 2 PC.

Remarque : A l'occasion, il se peut
que le logiciel vous invite a faire la
mise a niveau. Ceci est facultatif, ce
n’est pas requis.

Vous trouverez le logiciel en cliquant sur Démarrer »
Tous les programmes » Cyberlink PowerDirector.
Vous pouvez également l'ouvrir en double-cliquant
l'icbne sur le bureau de votre ordinateur.

La premiére fois que vous ouvrez PowerDirector, vous serez invité a entrer le numéro de série.
Vous trouverez le numéro sur I'enveloppe du CD-ROM puis saisissez-le.
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MAC

1. Insérez le CD-ROM dans le lecteur CD-ROM de votre ordinateur.
2. Installez les pilotes et le logiciel.

Double-cliquez sur le CD-ROM inséré, sur le dossier « Mac », et sur le fichier « EZCap FR.pkg ».
Suivez les instructions a I'écran pour compléter l'installation. Une fois I'installation complétée, vous
devez redémarrer I'ordinateur pour compléter le processus d'installation.

Vous pouvez éjecter le CD-ROM.
3. Raccordez I'appareil.

Branchez le VIDEO 2 PC a un port USB 2.0 de votre ordinateur. (Nous vous recommandons de le
brancher a un port USB sur le panneau arriere de I'ordinateur.)

4. Vous pouvez maintenant utiliser le VIDEO 2 PC.
Vous trouverez I'application dans le dossier Applications » EzCAP » EzCAP Capture.
La premiére fois que vous ouvrez EzCAP, vous serez invité a entrer le numéro de série dans le
champ « Serial Number ». Vous trouverez le numéro sur I'enveloppe du CD-ROM EzCAP,
saisissez-le dans le champ, puis cliquez sur « OK ».
Une fois EzCAP installé, vous pouvez utiliser VIDEO 2 PC a partir de n'importe quelle application
sur votre Mac qui utilise des numériseurs vidéo QuickTime, telles que Apple QuickTime Player.

18



E D’ENSEMBLE

ORDINATEUR PERIPHERIQUE DE LECTURE

[ | ===

Magnétoscope

Téléviseur

Caméra
numérique

...etc.

IMPORTANT :

Afin de capter le son d’'un vidéo, branchez les entrées gauche et droite aux sorties gauche et droite de I'appareil
de visionnement.

Pour capturer I'image vidéo, sélectionnez soit I'entrée vidéo composite ou 'entrée S-vidéo.

1.

CONNECTEUR USB - Branchez le cable de prolongation USB inclus pour brancher le VIDEO 2 PC a un
port USB 2 de votre ordinateur, préférablement sur le panneau arriére.

ENTREES AUDIO - Utilisez des cables RCA standards pour brancher les entrées gauche et droite aux
sorties gauche et droite de I'appareil de visionnement. Assurez-vous que les couleurs correspondent aux
entrées (rouge/rouge et blanc/blanc).

ENTREE VIDEO COMPOSITE - Utilisez un céable composite vidéo standard pour brancher cette entrée a
la sortie composite vidéo du périphérique de lecture. (Si votre le périphérique de lecture dispose d’'une
sortie S-Video, vous pouvez la raccorder a I'entrée S-Video au lieu d'utiliser I'entrée vidéo composite.)

ENTREE S-VIDEO - Utilisez un cable S-Video standard (pas inclus) pour brancher cette entrée a la sortie
S-Vidéo du périphérique de lecture. (Généralement, les connexions S-Video sont offrent une meilleure
qualité vidéo que les connexions composites vidéo, c'est pourquoi nous recommandons d'utiliser cette
entrée S-Video si votre périphérique de lecture dispose d’une sortie S-Video.)
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PowerDirector (PC) .
Remarque : A ['occasion, il se peut

1. Branchez le VIDEO 2 PC a l'appareil de visionnement et a = S X
votre ordinateur (comme indiqué dans la section VUE | due le logiciel vous invite a faire la
D’ENSEMBLE). mise a niveau. Ceci est facultatif, ce

n’est pas requis.

2. Lancer I'application PowerDirector. Vous trouverez le logiciel P q

en cliqguant sur Démarrer » Tous les programmes »
Cyberlink PowerDirector. (Vous pouvez également I'ouvrir Remarque: Pour de plus amples

en double-cliquant I'icéne sur le bureau de votre ordinateur.) informations  sur  [lutilisation de
3. Cliquez sur l'onglet « Capture » situé dans le coin supérieur  PowerDirector, cliquez sur la touche
gauche de lécran. Le logiciel devrait détecter = F1 de votre clavier ou sur icone de la
automatiquement votre périphérique de lecture. chaise du directeur dans le coin
4. Lancez [lenregistrement en cliquant sur le bouton | 9auche de la fenétre, et cliquez sur

« Aide », puis sur «Aide pour
PowerDirector » afin d’accéder au
fichier d’aide du logiciel.

d’enregistrement. Faites jouer votre source vidéo (caméra
numérique, téléviseur, lecteur DVD, etc.).

5. Lorsque vous avez terminé avec la capture de la vidéo,
cliquez sur le bouton d’arrét.
6. Entrez le nom de la vidéo dans le champ « Nom du fichier * Remarque: Dans certains cas
que : 8

capturé » de la fenétre qui s'ouvre et cliquez sur « OK ». La selon le systtme d'exploitation de
vidéo devrait s'afficher dans la fenétre du contenu dans le bas | yotre ordinateur, il se peut que la

de la fenétre. capture d'image de votre vidéo puisse
e Si vous désirez créer un CD, cliquez sur longlet paraitre un peu saccadée ou
« Créer un disque ». Utilisez les boutons sous I'onglet « gelée ». Ceci n’affectera en rien

« Contenu du disque » afin d’ajouter d’autres vidéos a votre vidéo, la capture se fait
mettre sur le CD, puis cliquez sur « Graver » afin de correctement
graver un CD.

e Si vous désirez sauvegarder la vidéo dans un format populaire (tel que MPEG-4 pour PSP, iPod"®
ou iPhone"), cliquez sur longlet « Modifier », cliquez sur 'onglet « Produire » et sélectionnez le
format désiré.

* Sivous désirez téléverser la vidéo sur YouTube" ou Facebook™, cliquez sur l'onglet « Modifier »,
cliqguez sur l'onglet « Produire » et sélectionnez I'onglet « YouTube » ou « Facebook » dans le
haut de la fenétre.

iPhone et iPod sont des marques de commerce déposées de Apple, inc., enregistrée aux Etats-Unis et dans d'autres pays.
YouTube est une marque de commerce de YouTube, LLC.
Facebook est une marque de commerce déposée de Facebook, inc.
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EzCAP Capture (Mac)

1.

Branchez le VIDEO 2 PC au périphérique de lecture et a votre . .
ordinateur (comme indiqué dans la secton VUE . _Remarque: Dans’ certains  cas,
D’ENSEMBLE). Assurez-vous de toujours brancher le VIDEO ~ Sélon le systeme d'exploitation de
2 PC a votre ordinateur avant de lancer le logiciel. votre ordinateur, il se peut que la
Lancez EzCAP Capture capture d'image de votre vidéo puisse
: araitre  un eu saccadée ou
Vous trouverez I'application dans le dossier Applications » P 5 P s :
EZCAP » E2CAP « gelée ». Ceci n’affectera en rien

) . N votre vidéo, la capture se fait
La premiére fois que vous ouvrez EzCAP, vous serez invité a correctement. Si cela se produit, nous

entrer le numéro de série dans le champ « Serial Number ». vous recommandons d'utiliser
Vous trouverez le numéro sur l'enveloppe du CD-ROM QuickTime  afin  d'optimiser le
EzCAP, saisissez-le dans le champ. monitorage  vidéo. Consultez les

EzCAP Capture est maintenant ouvert. (Remarque : Faites instructions QuickTime pour plus de
jouer votre source vidéo (caméra numérique, téléviseur, détails.

lecteur DVD, etc.) tout de suite. Vous devez d’abord régler les

paramétres audio.) Cliquez sur « Record » dans le menu supérieur et sélectionnez « Sound Settings ».
Dans la nouvelle fenétre, cliquez sur 'onglet « Source » et sélectionnez « ION Audio USB 2861 Device »
de la liste. Assurez-vous également que le menu prés de « Speaker » est réglé sur « On ». Lorsque vous
avez terminé, cliquez sur « OK ».

Lancez I'enregistrement en cliquant sur « Record » du menu supérieur et en sélectionnant « Record ». *
(Vous pouvez également cliquer sur les touches « Commande » + « R ».) Faites jouer votre source vidéo
(caméra numérique, téléviseur, lecteur DVD, etc.).

Lorsque vous avez terminé avec la capture, cliquez n'importe ou a l'intérieur de la boite dans le centre de
I'écran. Pour retourner a la fenétre principale, cliquez sur « OK ».

Pour de plus amples informations sur EzCAP Capture, veuillez consulter le guide d'utilisation (PDF) dans
le dossier « Mac » sur le CD.

Remarque importante!

Pour faire le visionnement de la capture vidéo sur votre iPod ou iPhone, la vidéo doit étre en format MPEG-4 de
type spécifique, méme si vous l'aviez déja sauvegardé en format MPEG-4 dans le logiciel. Afin de convertir la
vidéo pour la visionner sur votre appareil, procédez aux étapes suivantes :

1.

2.
3.
4

Capturez la vidéo, sauvegardez-la, puis fermez le logiciel.
Ouvrez le dossier Applications.
Lancez QuickTime, cliquez sur le menu « Fichier » et sélectionnez « Ouvrir fichier ».

Repérez le fichier vidéo et cliquez sur « Ouvrir ». La vidéo capturée devrait s’afficher automatiquement
dans QuickTime.

Cliquez le menu « Fichier » et sélectionnez « Enregistrer sous ». (Vous pouvez renommer le fichier ou
sélectionner un nouvel emplacement.)

Cliquez le menu déroulant « Format » et sélectionnez le format désiré.
Cliquez sur « Enregistrer ». Le fichier peut maintenant étre lu par votre appareil.
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QuickTime (Mac)

1.

10.

11.

12.

Branchez le VIDEO 2 PC au périphérique de lecture et a votre . .
ordinateur (comme indiqué dans la secton VUE  Remarque: Si votre ordinateur Mac
D’ENSEMBLE). utilise un systéme d’exploitation plus

Afin de pouvoir utiliser VIDEO 2 PC avec QuickTime, vous 29 i“’r; eé’ﬂf(’#?ﬁ D Bl R
devez d’abord enregistrer votre copie du logiciel EzCAP d? St’iDn dl,J ?" i?r r:nt ;posf;ehipa:s
Capture. Lancez I'application EzCAP Capture en cliquant sur TS CIES RIS C U

o vidéo. Si tel est le cas, nous vous

> > X o> o
Applications ”EfCAP EZCAP,captur?A recommandons de faire la mise a
Vous serez invité a entrer le numéro de série dans le champ niveau a QuickTime Pro afin de

« Serial Number ». Vous trouverez le numéro sur l'enveloppe pouvoir utiliser ces fonctions.

du CD-ROM EzCAP, saisissez-le dans le champ, puis cliquez

sur « OK ».

Une fois que vous avez entré le numéro de série et que I'application EzCAP Capture s’ouvre correctement,
vous pouvez la refermer.

Si vous utilisez Snow Leopard (Mac OS X 10.6), configurez d’abord QuickTime de maniere a ce qu'il
s’ouvre en version 32 bits. Cliquez sur le dossier Applications, faites un clic droit sur « QuickTime »,
sélectionnez « Lire les informations » et cochez I'option « Ouvrir en mode 32 bits », puis fermez la
fenétre.

Lancez QuickTime, cliquez sur le menu « Fichier » et sélectionnez « Nouvel enregistrement vidéo ».

Si vous voyez un triangle pointant vers le bas a droite du bouton d'enregistrement, cliquez-le afin d'ouvrir
un menu déroulant. Si vous ne voyez pas de triangle, cliquez sur le menu « QuickTime Player »dans le
haut de I'écran et sélectionnez « Préférences ».

A partir du menu déroulant, assurez-vous que les paramétres « Caméra » sont adéquats (« Composite »
ou « S-Video », selon le connecteur que vous utilisé) et que « USB 2861 Device » est sélectionné comme
« Microphone ». (Veuillez également vous assurer que le potentiométre a gauche sur la fenétre est
élevé.)

Lancez I'enregistrement en cliquant sur le bouton d’enregistrement dans le bas de la fenétre. Faites jouer
votre source vidéo (caméra numérique, téléviseur, lecteur DVD, etc.).

Lorsque vous avez terminé avec I'enregistrement, cliquez sur la touche d’arrét. La vidéo capturée devrait
s'afficher automatiquement dans QuickTime player. Pour la sauvegarder, cliquez sur « Fichier » et
sélectionnez « Enregistrer » (ou « Enregistrer sous » pour modifier le nom du fichier, sans modifier la
vidéo).

Si vous désirez que la vidéo capturée puisse étre lue par votre iPhone ou iPod, cliquez le menu déroulant
« Format » et sélectionnez le format désiré : « iPhone (mobile) », « iPhone » ou « iPod ».

Cliquez sur « Enregistrer ».
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CONTENUTI DELLA CONFEZIONE

. VIDEO 2 PC
. Cavo RCA audio/video

. CD recante il software
. Guida rapida
. Istruzioni di sicurezza e garanzia

INSTALLAZIONE DRIVER E SOFTWARE

Prima di iniziare, assicurarsi che il computer rispetti i seguenti requisiti di sistema:

PC:
¢ Microsoft Windows XP, Vista (32 o 64 bit) o 7 (32 o 64 bit)
* Risoluzione dello schermo: 1024 x 768, 16-bit (o superiore)
e Pentium 2 450 MHz (o simile) o superiore
e 512 MB RAM (si consiglia 2GB o piu)
« 10 GB di spazio libero su disco fisso
« Porta USB 2.0 disponibile (preferibilmente a livello del pannello posteriore)
e Lettore CD o DVD-ROM
e Opzione: masterizzatore DVD

=
]
H

e OS X 10.5.6 (o superiore)

e 1.5 GHz Intel Core Solo

* 1GB 667 MHz DDR2 SDRAM

* 10 GB di spazio libero su disco fisso

* Porta USB 2.0 disponibile (preferibilmente a livello del pannello posteriore)
e Lettore CD o DVD-ROM

e Opzione: masterizzatore DVD



WINDOWS

3.

4.

Inserire il CD nel lettore CD del computer.
Installare i driver.

Nella finestra che appare dopo aver inserito il CD, cliccare su "Install » Driver" (installa driver per
PC). Seguire le istruzioni su schermo per completare I'installazione.

Se questa finestra non compare automaticamente, fare doppio clic su "Risorse del computer" e
quindi sul CD. La finestra dovrebbe apparire. (Se la finestra ancora non appare, fare clic col tasto
destro del mouse sul CD e selezionare "Esplora." Una volta che compaiono i contenuti del CD, fare
doppio clic sulla cartella "PC", fare doppio clic sulla cartella "Driver" e quindi su "Setup.exe.")

Installare il software.

Nella finestra che compare dopo aver inserito il CD, cliccare su "Install » Software". Seguire le
istruzioni su schermo per completare I'installazione.

Se questa finestra non compare automaticamente, fare doppio clic su "Risorse del computer" e
quindi sul CD. La finestra dovrebbe apparire. Se la finestra ancora non appare, fare clic col tasto
destro del mouse sul CD e selezionare "Esplora". Una volta che compaiono i contenuti del CD, fare
doppio clic sulla cartella "PC", fare doppio clic sulla cartella "Software", fare doppio clic sulla cartella
"Cyberlink..." e quindi su "Setup.exe".

Si puo ora espellere il CD e iniziare a utilizzare il VIDEO 2 PC ed il software installato.

Collegare il dispositivo.

Collegare il VIDEO 2 PC ad una porta USB2.0 libera sul computer. (Si consiglia di collegarlo ad
una porta sul pannello posteriore del computer.)

Diverse finestre di dialogo possono comparire nell'angolo dello schermo a indicare che il computer
ha percepito che il VIDEO 2 PC & collegato. In alcuni casi pud comparire un messaggio che
sembra un messaggio di errore: & normale. Cliccare su "OK" (se necessario).

Cominciamo!

Il software pud essere reperito recandosi su Start Menu
» Tutti i programmi » Cyberlink PowerDirector. (Si
pud anche fare doppio clic sull'icona di scelta rapida l'aggiormamento dopo —
presente sul Desktop del computer.) aperto. Questo & opzionale, non
La prima volta che si apre il PowerDirector, verra chiesto richiesto.

di inserire un numero di serie. Il numero di serie &

presente sulla custodia del CD; inserirlo.

Nota bene: Talvolta il software
chiedera se si desidera effettuarne
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MAC

1. Inserire il CD nel lettore CD del computer.
2, Installare i driver e il software.

Fare doppio clic sul CD sul Desktop, sulla cartella "Mac" e sul file "EZCap ITA.pkg". Seguire le
istruzioni su schermo per completare I'installazione. Per completare il processo, occorrera riavviare
il computer.
Si puo ora espellere il CD.

3. Collegare il dispositivo.
Collegare il VIDEO 2 PC ad una porta USB2.0 libera sul computer. (Si consiglia di collegarlo ad
una porta sul pannello posteriore del computer.)

4. Cominciamo!
Si puo trovare il software recandosi su Applicazioni » EzCAP » EzCAP Capture.
La prima volta che si apre il EzZCAP, verra chiesto di inserire un numero di serie nel campo "Serial
Number" (numero di serie). |l numero di serie & presente sulla custodia del CD EzCAP; inserirlo e
cliccare su "OK".
Dopo aver installato il EzCAP, si puo anche utilizzare il VIDEO 2 PC in qualsiasi programma che
impieghi video ritocco QuickTime, come Apple QuickTime Player.
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PANORAMIC

COMPUTER DISPOSITIVO DI
RIPRODUZIONE VIDEO

VCR

TV

(Qﬁ videocamera

l ‘ digitale
—

...eCC.

IMPORTANTE:

per captare il suono di un video, collegare gli INGRESSI AUDIO sinistro e destro alle uscite audio sinistra e
destra del dispositivo di riproduzione.

Per captare I''mmagine del video stesso, scegliere 'INGRESSO VIDEO COMPOSITO oppure I''NGRESSO S-
VIDEO.

1. CONNETTORE USB - Collegare questo capo del VIDEO 2 PC alla prolunga USB in dotazione, quindi
collegare la prolunga ad una porta USB 2.0 disponibile del computer (preferiblmente una porta presente
sul pannello posteriore).

2. INGRESSI AUDIO - Servirsi di cavi RCA standard per collegare questi ingressi audio alle uscite sinbistra
e destra del dispositivo di riproduzione. Assicurarsi di abbinare i colori nel modo giusto: rosso con rosso e
bianco con bianco.

3. INGRESSO VIDEO COMPOSITO - Servirsi di un cavo standard video composito per collegare questo
ingresso all'uscita video composita del dispositivo di riproduzione. (se invece quest'ultimo & dotato di
un'uscita S-Video, & possibile collegarla allINGRESSO S-VIDEO.)

4. INGRESSO S-VIDEO - Servirsi di un cavo standard S-Video (non incluso) per collegare questo ingresso
all'uscita S-Video del dispositivo di riproduzione. (Solitamente i collegamenti S-Vieo sono di qualita
migliore rispetto a quelli video compositi, quindi consigliamo di servirsi di questi se il dispositivo di
riproduzione ¢ dotato di un'uscita S-Video.)
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PRIMI PASSI

PowerDirector (PC)

1.

Collegare il VIDEO 2 PC al dispositivo di riproduzione ed al
computer (come illustrato nel paragrafo PANORAMICA).

Aprire il PowerDirector. |l software pud essere reperito
recandosi su Start » Tutti i programmi » Cyberlink
PowerDirector. (Si pud anche fare doppio clic sullicona di
scelta rapida presente sul Desktop del computer.)

Cliccare sulla scheda "Capture" (acquisisci) nell'angolo
superiore sinistro dello schermo. Il software individuera
automaticamente il dispositivo video.

Iniziare la registrazione cliccando sul tasto rosso "Record"
(registra). Riprodurre la sorgente video (videocamera digitale,
lettore DVD, ecc.).

Una volta finito di acquisire il video, cliccare sul tasto "Stop".
Inserire il titolo del video nel campo "Captured File Name"
(nome file acquisito) nella finestra che appare e cliccare su
"OK". |l video apparira in "contenuti acquisiti" in fondo alla
finestra.

e Se si desidera creare un CD, cliccare sulla scheda
"Create Disc". Servirsi dei tasti al di sotto della scheda
"Content" (contenuto) per aggiungere i video che si
desidera sul CD, quindi cliccare su "Burn" (masterizza)
per masterizzare il disco.

* Se si desidera salvare un video in un formato popolare

Nota bene: Talvolta il software
chiedera se si desidera effettuarne
l'aggiornamento dopo averlo aperto.
Questo e opzionale, non richiesto.

Nota bene: Per informazioni piu
approfondite sull'uso del
PowerDirector, premere F1 sulla
tastiera e cliccare sullicona della
"sedia da regista" presente nell'angolo
superiore sinistro dello schermo e
recarsi su "Help" quindi
"PowerDirector Help" per accedere
al file di aiuto del software.

*Nota bene: In alcuni casi, a seconda
del sistema operativo del computer,
limmagine del video in PowerDirector
puo apparire "mossa" o "in stallo".
Questo tuttavia non influira
negativamente sul video: in realta lo
sta acquisendo in maniera corretta.

(ad es. MPEG-4 portatile per PSP, iPod™, o iPhone™), cliccare sulla scheda "Edit" (modificare),
cliccare sulla scheda "Produce” (produci) e selezionare il giusto formato.

e Se si desidera caricare un video su YouTube™ o Facebook™, cliccare sulla scheda "Edit"
(modificare), cliccare sulla scheda "Produce" (produci), quindi sulla scheda "YouTube" o

"Facebook" vicino alla parte superiore della finestra.

iPhone e iPod sono marchi di fabbrica di Apple, Inc., registrati negli Stati Uniti e in altri Paesi.

YouTube é un marchio registrato di YouTube, LLC.
Facebook® é un marchio registrato di Facebook, Inc.
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EzCAP Capture (Mac)

1.

Collegare il VIDEO 2 PC al dispositivo di riproduzione ed al . . X
computer (come illustrato nel paragrafo PANORAMICA). I  Nota bene: In alcuni casi, a seconda
VIDEO 2 PC deve essere collegato al computer affinché il del sistema operativo del computer,

software si apra adeguatamente. limmagine del video in EzCAP puo
apparire "mossa" o "in stallo”. Questo

ﬁprlrﬁ Ez_CAP}(éa;gu;;.» g s(:o;tl\;vare si trova recandosi su tuttavia non influird negativamente sul

pplicazioni b £z ZCAF. video: in realta lo sta acquisendo in
La prima volta che si apre EzCAP, verra richiesto di inserire il maniera corretta. Se cid avviene,
numero di serie. Il numero si trova sulla custodia del CD tuttavia, si consiglia di utilizzare
del'EzCAP CD: inseritlo. QuickTime per un monitoraggio video

EzCAP Capture & ora aperto. (Nota bene: non riprodurre il fluido. Si vedano le istruzioni di
ancora la sorgente video (videocamera digitale, TV, chkT_lme seguenti per maggiori
lettore DVD, ecc.). Per prima cosa va configurato I'audio dettagli.

del software.)

Cliccare su "Record" nel menu superiore e selezionare "Sound Settings" (configurazioni audio). Nella
finestra che compare, cliccare sulla scheda "Source" e selezionare "ION Audio USB 2861 Device"
dall'elenco. Inoltre, assicurarsi che il menu di fianco "Speaker" sia su "On". Cliccare su "OK" una volta
finito.

Iniziare a registrare cliccando su "Record" nel menu superiore e selezionando "Record". * (Si puo anche
premere "Command” + R".) Riprodurre la sorgente video (videocamera digitale, lettore DVD, ecc.).

Una volta finito di acquisire il video, cliccare in qualsiasi punto all'interno della casella al centro dello
schermo. Per tornare alla schermata principale, cliccare su "OK".

Per maggiori informazioni sull'uso di EzCAP Capture, fare riferimento al manuale (PDF) contenuto nella
cartella "Mac" del CD in dotazione."

Nota importante!

Per riprodurre il video acquisito su iPod o iPhone, il video deve essere in un tipo specifico di formato MPEG-4,
anche se il video e gia stato salvato in formato MPEG-4 nel software. Per convertire il video da riprodurre sul
dispositivo, seguire queste fasi.

1.

[l

24

Acquisire il video, salvarlo e chiudere il software.

Aprire la cartella Applicazioni .

Aprire QuickTime, cliccare sul menu "File" e selezionare "Open File" (apri file).
Individuare il video da acquisire e cliccare su "Apri." Il video si aprira in QuickTime.

Cliccare sul menu "File" e selezionare "Save As" (salva con nome). (E possibile rinominare o il filmato o
salvarlo in una nuova sede, se desiderato.)

Cliccare sul menu a discesa "Format" e selezionare il dispositivo.
Cliccare su "Save" (salva). Il file pud ora essere riprodotto sul dispositivo.
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QuickTime (Mac)

1.

10.

1.

12.

Collegare il VIDEO 2 PC al dispositivo di riproduzione ed al .
computer (come illustrato nel paragrafo PANORAMICA). Nota bene: Se sul Mac & presente un

istem rati i hi b
Per utilizzare il VIDEO 2 PC con QuickTime, bisogna prima f'g:) e s C';’ui(ffﬁnf -

registrare il software EzCAP Capture. Aprire il EzCAP resent tr non re l'opzion
Capture recandosi su Applicazioni » EzCAP » EzCAP gie?:gi:trgcr)eegbesa:laraeveﬁﬁn:tﬁzw |ﬁ

Capture. questo caso, si consiglia di aggiornare
Verra richiesto di inserire un numero di serie nel campo il programma a QuickTime Pro per
"Serial Number" (numero di serie). Il numero di serie & avere accesso a tali funzioni.

presente sulla custodia del CD EzCAP; inserirlo e cliccare su

Dopo aver inserito il numero di serie e dopo che il EzZCAP Capture si apre, & possibile chiuderlo.

Se si utilizza Snow Leopard (Mac OS X 10.6), prima di iniziare impostare QuickTime in modo che si apra a
32 bit. Per farlo, recarsi sulla cartella Applicazioni , fare clic col tasto destro su "QuickTime" e
selezionare "Get Info", spuntare la casella "Open in 32-bit mode" (apri in modalita a 32 bit che appare,
quindi chiudere la finestra.

Aprire QuickTime, cliccare sul menu "File" e selezionare "New Movie Recording".

Se viene visualizzato un triangolo rivolto verso il basso a destra del tasto "record" (registra), cliccarvi sopra
per aprire un menu a discesa. Se il triangolo non compare, cliccare sul menu "QuickTime Player" in cima
allo schermo e selezionare "Preferences".

Nel menu a discesa, assicurarsi che sia selezionata la giusta configurazione della "Camera"
("Composite" o "S-Video," a seconda del connettore in uso) e che "USB 2861 Device" (dispositivo USB
2861) sia selezionato come "Microphone" (microfono). (Inoltre, assicurarsi che il cursore del volume
presente sul lato sinistro della finestra sia alzato.)

Iniziare a registrare cliccando sul tasto "record" (registra) in fondo allo schermo. Riprodurre la sorgente
video (videocamera digitale, lettore DVD, ecc.).

Una volta finito di acquisire il video, cliccare sul tasto "stop". Il video acquisito si aprira automaticamente
nel lettore QuickTime. Per salvarlo, recarsi su "File" e selezionare "Save" (salva) (o "Save As" (salva con
nome) per salvarlo con un nome diverso, ma salvarlo come filmato "indipendente").

Se si desidera che il video acquisito sia riproducibile su iPhone o iPod, cliccare sul menu a discesa
"Format" e selezionare il dispositivo: "iPhone (cellulare)," "iPhone," o "iPod."

Cliccare su "Save" (salva).
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VIDEO 2 PC

RCA Audio-/Video-Kabel

Software-CD

Schnellstart-Anleitung

Sicherheitshinweise und Garantieinformationen

TREIBER & SOFTWARE-INSTALLATION

Bevor Sie beginnen, vergewissern Sie sich, dass lhr Computer folgende Systemvoraussetzungen erfiillt:

PC:

Microsoft Windows XP, Vista (32- oder 64-Bit) oder 7 (32- oder 64-Bit)
Bildschirmauflosung: 1024 x 768, 16-Bit (oder héher)

Pentium 2 450 MHz (oder vergleichbar) oder héher

512 MB RAM (2GB oder mehr empfohlen)

10 GB freier Festplattenspeicher

Ein freier USB 2.0-Anschluss (vorzugsweise auf der Riickseite des Computers)
CD- oder DVD-ROM-Laufwerk

Optional: DVD-Brenner

OS X 10.5.6 (oder hoher)

1,5 GHz Intel Core Solo

1 GB 667 MHz DDR2 SDRAM

10 GB freier Festplattenspeicher

Ein freier USB 2.0-Anschluss (vorzugsweise auf der Riickseite des Computers)
CD- oder DVD-ROM-Laufwerk

Optional: DVD-Brenner
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WINDOWS

1.
2.

3.

4.

5.

Legen Sie die CD in das CD-Laufwerk Ihres Computers ein.
Installieren Sie die Treiber.

Klicken Sie im Fenster, das nach dem Einlegen der CD erscheint, auf "Install » Driver." Befolgen
Sie die Anweisungen auf dem Bildschirm, um die Installation abzuschlieBen.

Wenn dieses Fenster nicht automatisch aufscheint, doppelklicken Sie erst auf ,Mein Computer*
und anschlieBend auf die CD. Das Fenster sollte nun angezeigt werden. (Wenn das Fenster immer
noch nicht angezeigt wird, rechtsklicken Sie auf die CD und wéhlen "Explorer". Sobald die Inhalte
der CD angezeigt werden, doppelklicken Sie auf den Ordner "PC", auf den Ordner "Driver" und
danach auf "Setup.exe".)

Installieren Sie die Software.

Klicken Sie im Fenster, das nach dem Einlegen der CD erscheint, auf "Install » Software".
Befolgen Sie die Anweisungen auf dem Bildschirm, um die Installation abzuschlieBen.

Wenn dieses Fenster nicht automatisch aufscheint, doppelklicken Sie erst auf ,Mein Computer”
und anschlieBend auf die CD. Das Fenster sollte nun angezeigt werden. Wenn das Fenster immer
noch nicht angezeigt wird, rechtsklicken Sie auf die CD und wéhlen "Explorer". Sobald die Inhalte
der CD angezeigt werden, doppelklicken Sie auf den Ordner "PC", doppelklicken Sie auf den Ordner
"Software", auf den Ordner "Cyberlink..." und danach auf "Setup.exe".

Sie kénnen die CD entfernen und damit beginnen VIDEO 2 PC und die installierte Software zu
verwenden.

SchlieBen Sie das Geriét an.

Um VIDEO 2 PC an einen freien USB2.0-Anschluss |hres Computers anzuschlieBen. (Wir
empfehlen Ihnen das Gerat mit einem Anschluss an der Riickseite lhres Computers zu verbinden.)
Es kann sein, dass mehrere Dialogfelder in einer Bildschirmecke aufscheinen, die anzeigen, dass
der Computer die Verbindung mit VIDEO 2 PC erkannt hat. In einigen Féllen kann es sein, dass
Sie eine Meldung sehen, die einer Fehlermeldung &hnelt - das ist jedoch normal. Klicken Sie auf
"OK" (falls nétig).

Los geht’s!

Sie finden die Software, indem Sie Start-Menii » Alle

Programme » CyberLink PowerDirector wéhlen.

(Sie kénnen auch auf das entsprechende Symbol auf Sie aktualisi scht Dies ist

lhrem Desktop doppelklicken.) 1D AURAIRIEED leEnEt =B 5
N k . optional und nicht zwingend

Wenn Sie PowerDirector das erste Mal 6ffnen, werden erforderlich.

Sie aufgefordert, eine Seriennummer einzugeben.

Suchen Sie die Nummer auf der CD-Hdille, geben Sie sie ein.

Hinweis: Manchmal wird Sie die
Software nach dem Offnen fragen, ob

31



MAC

Legen Sie die CD in das CD-Laufwerk Ihres Computers ein.
Installieren Sie die Treiber und die Software.
Doppelklicken Sie auf die CD am Desktop, auf den Ordner "Mac" und auf die Datei "EZCap
DE.pkg." Befolgen Sie die Anweisungen auf dem Bildschirm, um die Installation abzuschlieBen.
Sie mussen anschlieBend Ihren Computer neu starten, um diesen Prozess abzuschlieen.
SchlieBen Sie das Gerit an.
Um VIDEO 2 PC an einen freien USB2.0-Anschluss |hres Computers anzuschlieBen. (Wir
empfehlen Ihnen das Gerat mit einem Anschluss an der Riickseite lhres Computers zu verbinden.)
Los geht’s!
Sie kénnen die CD entfernen und damit beginnen VIDEO 2 PC und die installierte Software zu
verwenden. Sie finden die Software, indem Sie Applikationen » EzCAP » EzCAP Capture
wéhlen.
Wenn Sie EzCAP das erste Mal 6ffnen, werden Sie aufgefordert, eine Seriennummer in das Feld
"Seriennummer" einzugeben. Suchen Sie die Nummer auf der EzZCAP CD-Hilille, geben Sie sie ein
und klicken danach auf "OK".
Nachdem Sie EzCAP installiert haben, kénnen Sie VIDEO 2 PC in jedem beliebigen Programm
verwenden, das QuickTime-Video-Digitizer verwendet, wie Apple QuickTime Player.
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COMPUTER

VIDEOWIEDERGABE-GERAT

...etc.

WICHTIG:

Um den Ton eines Videos zu erfassen, verbinden Sie die linken und rechten AUDIO-EINGANGE mit den linken
und rechten Audio-Ausgéngen lhres Wiedergabe-Gerits.

Zur Erfassung des Videobildes selbst wéahlen Sie entweder den COMPOSITE VIDEO-EINGANG oder den S-
VIDEO-EINGANG.

1.

USB-ANSCHLUSS - SchlieBen Sie dieses Ende des VIDEO 2 PC an das mitgelieferte USB-
Verlangerungskabel an und schlieBen Sie das Verlangerungskabel an einen freien USB 2.0-Anschluss
lhres Computers an (vorzugsweise an einen Anschluss auf der Ruckseite).

AUDIO-EINGANGE - Verwenden Sie Standard-Cinch-Kabel, um diese linken und rechten Audio-Eingange
mit den linken und rechten Audio-Ausgangen Ihres Wiedergabe-Geréts zu verbinden. Achten Sie darauf,
dass die Farben (ibereinstimmen - rot zu rot, weif3 zu weil3.

COMPOSITE-VIDEO-EINGANG - Verwenden Sie ein Standard-Composite-Video-Kabel, um diesen
Eingang mit dem Composite-Video-Ausgang lhres Wiedergabe-Gerats zu verbinden. (Wenn Ihr
Wiedergabe-Gerat einen S-Video-Ausgang besitzt, kénnen Sie diesen stattdessen mit dem S-VIDEO-
EINGANG verbinden.)

S-VIDEO-EINGANG - Verwenden Sie ein Standard-S-Video-Kabel (nicht inbegriffen), um diesen Eingang
mit dem S-Video-Ausgang |hres Wiedergabe-Gerats zu verbinden. (In der Regel sind S-Video-
Verbindungen von besserer Qualitat als Composite-Video, daher empfehlen wir Ihnen diese zu verwenden,
wenn lhr Wiedergabe-Gerét (iber einen S-Video-Ausgang verflgt.)
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PowerDirector (PC)
1. Verbinden Sie VIDEO 2 PC mit lhrem Wiedergabe-Gerat und . L. . . .
lhrem Computer (wie in der UBERSICHT beschrieben). Hinweis: Manchmal wird Sie die

N Software nach dem Offnen fragen, ob
2. Offnen Sie PowerDirector.  Sie finden die Software, indem Sie aktualisieren méchten. Sies ist

Sie Start-Menii » Alle Programme » Cyberlink optional und nicht  zwingend
PowerDirector wahlen. (Sie  koénnen auch auf das erforderlich.
entsprechende Symbol auf Inrem Desktop doppelklicken.)

3. Klicken Sie auf die Registerkarte "Erfassen" in der oberen

Hinweis: Fir weitere ausfiihrliche
Informationen zur Verwendung des
PowerDirector, driicken Sie F1 auf

linken Ecke des Bildschirms. Die Software erkennt das
Videogerét automatisch.

4. Starten Sie die Aufnahme, indem Sie die rote "Aufnahme"- Ihrer Tastatur oder klicken Sie auf das
Taste betdtigen. ~Geben Sie lhre Videoquelle wieder | "Regiestuhl’-Symbol am oberen linken
(Digitalkamera, TV, DVD-Player etc.). Bildschirmrand, und wahlen ,Hilfe®

5. Wenn Sie mit dem Erfassen lhres Videos fertig sind, klicken und dann ,PowerDirector Hilfe*, um
Sie auf die Taste "Stop". zur Hilfe-Datei der Software zu

6. Im angezeigten Fenster geben Sie nun den Titel lhres Videos gelangen.

im Feld "Name der erfassten Datei" ein und klicken Sie auf
"OK". Das Video wird im Bereich ,Erfasste Inhalte“ am * Hinweis: In einigen Fallen - je nach

unteren Rand des Fensters angezeigt. Betriebssystem Ihres Computers —

e Wenn Sie eine CD erstellen méchten, klicken Sie auf kann es sein, dass Ihr Video in
die Schaltflache "Disk erstellen". Verwenden Sie die PowerDirector "ruckelig”" oder ‘ins
Schlatflaichen unterhalb der Registerkarte ‘“Inhalte”, Stocken geraten" wirkt. Dies wirkt
um die Videos hinzuzufiigen, die Sie auf die CD sich jedoch nicht auf das Video aus —
brennen mochten, und klicken Sie dann auf das Video selbst wird korrekt erfasst.
"Brennen".

e Wenn Sie ein Video in einem gangigen Format (z.B. dem MPEG-4-Format fur tragbare Gerate wie
PSP, iPod™ oder iPhone™) speichern mdchten, klicken Sie auf die Registerkarte "Bearbeiten”,
klicken Sie auf die Registerkarte "Erstellen" und wahlen das entsprechende Format.

e Wenn Sie ein Video auf YouTube™ oder Facebook™ laden mdchten, klicken Sie auf die
Registerkarte "Bearbeiten”, klicken Sie auf die Registerkarte "Erstellen" und anschlieBend auf die
Registerkarten "YouTube" oder "Facebook" am oberen Rand des Fensters.

iPhone und iPod sind Marken der Apple Inc. und in den USA und anderen Landern eingetragen.
YouTube ist eine Marke der YouTube, LLC.
Facebook ist eine eingetragene Marke der Facebook, Inc.
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EzCAP Capture (Mac)

1.

Verbinden Sie VIDEO 2 PC mit lhrem
Wiedergabe-Gerat und Ihrem Computer (wie in
der UBERSICHT beschrieben). VIDEO 2 PC
muss mit dem Computer verbunden werden,
damit die Software ordnungsgeméaB gedffnet
werden kann.

* Hinweis: In einigen Fallen - je nach
Betriebssystem |lhres Computers — kann es sein,
dass lhr Video in EzCAP ‘"ruckelig" oder "ins
Stocken geraten" wirkt. Dies wirkt sich jedoch
nicht auf das Video aus — das Video selbst wird

2. Offnen Sie EzCAP Capture. Die Software ist unter = korrekt erfasst. Wenn dies geschieht, empfehlen
Anwendungen » EzCAP » EzCAP zu finden. wir Ihnen trotzdem QuickTime zu verwenden, um
3. Wenn Sie EzCAP das erste Mal 6ffnen, werden = €ine fllissige Ansicht zu ermoglichen.  Siehe

Sie aufgefordert, eine Seriennummer einzugeben.
Suchen Sie die Nummer auf der Hille der

unten angegebene QuickTime-Anweisungen flir
Details.

EzCAP-CD und geben Sie sie ein.

4. EzCAP Capture ist jetzt gedffnet. (Hinweis: Geben Sie Ihre Videoquelle noch nicht wieder (Digitalkamera,
TV, DVD-Player etc.). Sie mussen zuerst die Audioeinstellungen fir die Software vornehmen.))

5. Klicken Sie auf "Aufnahme" im oberen Menu und wéhlen Sie "Sound-Einstellungen." Im nun
angezeigten Fenster klicken Sie auf die Registerkarte "Quelle" und wéhlen Sie aus der Liste darunter "ION
Audio USB 2861 Gerat". Stellen Sie auBerdem sicher, dass das Menli neben "Lautsprecher" auf "Ein"
steht. Klicken Sie auf "OK", wenn Sie fertig sind.

6. Starten Sie die Aufnahme, indem Sie im oberen Menii auf "Aufnahme" klicken und dann "Aufnehmen"
wahlen. * (Sie kénnen auch "Befehl" + "R" dricken) Geben Sie das Video lhrer Videoquelle wieder
(Digitalkamera, TV, DVD-Player etc.).

7. Wenn Sie mit dem Erfassen lhres Videos fertig sind, klicken Sie auf eine beliebige Stelle innerhalb der Box
in der Mitte des Bildschirms. Klicken Sie auf "OK", um wieder zum Hauptbildschirm zu gelangen.

Wichtiger Hinweis!

Um das aufgenommene Video auf Ihrem iPod oder iPhone abzuspielen, muss das Video in einer bestimmten Art
von MPEG-4-Format vorliegen, auch wenn Sie |hr Video bereits als MPEG-4 in der Software gespeichert haben.
Um ein Video zu konvertieren, damit Sie es auf lhrem Gerat wiedergeben kénnen, gehen Sie folgendermafBen
vor:

1. Erfassen Sie lhre Videos, speichern Sie sie und schlieBen dann die Software.

2. Offnen Sie Ihren Anwendungen-Ordner.

3. Offnen Sie QuickTime, klicken auf das Meni "Datei" und wahlen "Datei &ffnen." .

4 Suchen Sie das Video, das Sie gerade aufgenommen haben, und klicken auf "Offnen." Das Video wird

sich in QuickTime &ffnen.

5. Klicken Sie auf das Ment(i "Datei"und wahlen "Speichern als". (Sie kénnen den Film umbenennen oder bei
Bedarf an einem anderen Speicherort speichern.))

6. Klicken Sie auf das Drop-Down-Ment "Format" und wahlen Sie lhr Gerét aus.

7. Weitere Informationen Uber die Verwendung von EzCAP Capture entnehmen Sie bitte dem Handbuch
(PDF) im "Mac"-Ordner auf der mitgelieferten CD.

8. Klicken Sie auf "Speichern." Diese Datei kann nun auf Inrem Gerét abgespielt werden.
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QuickTime (Mac)

1.

10.

11.

12

Verbinden Sie VIDEO 2 PC mit Ihrem Wiedergabe-Gerét und

Ihrem Computer (wie in der UBERSICHT beschrieben). Hinweis: Wenn lhr Mac auf einem
] o alteren Betriebssystem lauft (z.B.
Um VIDEO 2 PC mit QuickTime nutzen zu kénnen, missen 10.4), kann es sein, dass lhre

Sie zuerst die EzZCAP Capture-Software registrieren. Offnen QuickTime-Version keine Filmdateien
Sie EzCAP Capture, indem Sie Applikationen » EzCAP » erfassen und speichern kann. Wenn
EzCAP Capture wahlen. dies der Fall ist, empfehlen wir eine

Sie werden aufgefordert, eine Seriennummer im Feld Aktualisierung auf QU|ckT|me"Pro, um
"Seriennummer" einzugeben. Suchen Sie die Nummer auf = diese Funktionen nutzen zu kénnen.
der EzCAP CD-Hlllle, geben Sie sie ein und klicken danach

auf "OK".

Nach Eingabe der Seriennummer und nachdem EzCAP Capture erfolgreich geoffnet werden konnte,
konnen Sie es wieder schlieBen.

Wenn Sie Snow Leopard (Mac OS X 10.6) verwenden, setzen Sie QuickTime in den 32-Bit-Modus bevor
Sie beginnen. Um dies zu tun, 6ffnen Sie den Ordner "Applikationen”, klicken mit der rechten Maustaste
auf "QuickTime", wahlen "Information" und haken das Kontrollkastchen "Im 32-Bit-Modus 6ffnen" im nun
angezeigten Fenster an und schlieBen das Fenster danach.

Offnen Sie QuickTime, klicken Sie auf das Meni "Datei" und wahlen Sie "Neuen Film aufnehmen."

Wenn Sie ein nach unten zeigendes Dreieck rechts neben der "Aufnahme’-Taste sehen, klicken Sie es,
um ein Auswahlmenii zu éffnen.  Wenn Sie kein Dreieck sehen, klicken Sie auf das "QuickTime Player"-
Meni am oberen Bildschirmrand und wéhlen Sie "Einstellungen”.

Stellen Sie im Auswahimeni sicher, dass die richtige "Kamera"-Einstellung ausgewahlt wurde
("Composite" oder "S-Video*, je nachdem, welchen Anschluss Sie verwenden) und dass das "USB 2861
Geréat" als "Mikrofon“ ausgewahlt wurde. (Stellen Sie auBerdem sicher, dass der Lautstarkeregler auf der
linken Seite des Fensters aufgedreht ist.)

Starten Sie die Aufnahme, indem Sie die rote "Aufnahme"-Taste im unteren Teil des Bildschirms betéatigen.
Geben Sie |hre Videoquelle wieder (Digitalkamera, TV, DVD-Player etc.).

Wenn Sie mit dem Erfassen lhres Videos fertig sind, klicken Sie auf die Taste "Stopp". Das
aufgenommene Video wird automatisch im QuickTime-Player gedffnet. Um es zu speichern, wahlen Sie
"Datei" und "Speichern" (Bzw. "Speichern unter', um es unter einem anderen Namen zu speichern.
Speichern Sie die Datei jedoch als "eigenstandigen” Film).

Wenn Sie mdchten, dass die aufgenommenen Videos auf lhrem iPhone oder iPod abspielbar sind, klicken
Sie auf das Drop-Down-Men( "Format" und wahlen Sie |hr Gerat aus: "iPhone (Mobiltelefon)," "iPhone"
oder "iPod".

Klicken Sie auf "Speichern."
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INHOUD VERPAKKING

VIDEO 2 PC

RCA audio/videokabel

Software-cd

Snelstart Handleiding

Veiligheidsinstructies & Garantie Infobrochure

DRIVER & SOFTWARE INSTALLATIE

Alvorens te beginnen, verzeker uzelf ervan, dat uw computer aan deze systeemeisen voldoet.

PC:

Microsoft Windows XP, Vista (32- of 64-bit) of 7 (32- of 64-bit)
Schermresolutie: 1024 x 768, 16-bit (of meer)

Pentium 2 450 MHz (of vergelijkbaar) of beter

512 MB RAM of meer (2 GB of meer aanbevolen)

10 GB vrije ruimte op uw harddisk

Een beschikbare USB 2.0-poort (bij voorkeur op het achterpaneel)
cd-romspeler of dvd-station

Optioneel: dvd-brander

0OS X 10.5.6 (of hoger)

1.5 GHz Intel Core Solo

1 GB 667 MHz DDR2 SDRAM

10 GB vrije ruimte op uw harddisk

Een beschikbare USB 2.0-poort (bij voorkeur op het achterpaneel)
cd-romspeler of dvd-station

Optioneel: dvd-brander



WINDOWS

1.
2.

3.

4.

5.

Plaats de CD in uw computerdrive.
Installeer de drivers.

Op het venster dat verschijnt na het invoegen van de CD, klikt u op “Install » Driver”. Volg de
instructies die op het scherm verschijnen om de installatie te voltooien.

Als dit venster niet automatisch verschijnt, dubbelklik op “My Computer” en dubbelklik dan op de
CD. Het venster zou nu moeten verschijnen. (Indien het venster nog steeds niet verschijnt,
rechterklik op de CD en selecteer “Explore”. Zodra de inhoud van de CD verschijnt, dubbelklik dan
op de “PC” map, dubbelklik op de “Driver” map, en dubbelklik op “Setup.exe.”)

Installeer de software.

In het venster dat verschijnt na het plaatsen van de CD, klikt u op “Install PowerDirector". Volg de
instructies die op het scherm verschijnen om de installatie te voltooien.

Als dit venster niet automatisch verschijnt, dubbelklik op “My Computer” en dubbelklik dan op de
CD. Het venster zou nu moeten verschijnen. (Indien het venster nog steeds niet verschijnt,
rechterklik op de CD en selecteer “Explore”. Zodra de inhoud van de CD verschijnt, dubbelklik dan
op de “PC” map, dubbelklik dan op de “Software” map, dubbelklik op de “Cyberlink...” map, en
dubbelklik op “Setup.exe.”)

U kunt nu de CD ejecteren en VIDEO 2 PC gebruiken met de geinstalleerde software.

Het toestel koppelen.

Sluit de VIDEO 2 PC aan op een vrije USB 2.0-poort op uw computer. (We adviseren om deze met
een poort te verbinden aan de achterkant van uw computer.)

U zult diverse dialoogvensters onderaan het scherm, die aangeven of de computer de VIDEO 2 PC
heeft ontdekt en verbonden. In sommige gevallen, zult u een waarschuwing zien dat op een
foutmelding lijkt — dit is normaal. Klik “OK” (indien nodig).

Begin!

U zult de software vinden via: Start Menu » Alle
Programma’s » Cyberlink PowerDirector. (U kunt
ook op de snelkoppeling dubbelklikken op het
bureaublad van uw computer.)

Als u PowerDirector voor het eerst opent, zal u
gevraagd worden om een serienummer in te vullen. U vindt het nummer op de hoes van de CD,
voer deze in en klik op “OK”.

Opmerking: Soms zal de software
vragen of u wilt upgraden na deze te
hebben geopend. Dit is optioneel,
maar geen vereiste.
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MAC

1. Plaats de CD in uw computerdrive.

2, Installeer de drivers en software.
Dubbelklik dan op de CD van het bureaublad, dubbelklik op de map “Mac” en dubbelklik op het
bestand “EZCap NL.pkg”. Volg de instructies die op het scherm verschijnen om de installatie te
voltooien. U zult de computer moeten herstarten na het voltooien van dit proces.
U kunt nu de CD ejecteren.

3. Het toestel koppelen.
Sluit de VIDEO 2 PC aan op een vrije USB 2.0-poort op uw computer. (We adviseren om deze met
een poort te verbinden aan de achterkant van uw computer.)

4. Begin!
U kunt de software terugvinden via: Applicaties » EzCAP » EzCAP Capture.
Als u EzCAP voor het eerst opent, zal u gevraagd worden om een serienummer in te vullen in het
“Serial Number” veld. U vindt het nummer op de hoes van de EzCAP CD, voer deze in en klik op
“OK”.
Na het installeren van EzCAP, kunt u ook VIDEO 2 PC gebruiken in elk andere programma's die
QuickTime-video digitizers gebruikt, zoals Apple QuickTime Player.
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COMPUTER

VIDEO PLAYBACK TOESTEL

[ ]
VCR

Televisie

Digitale
camera

...eNZz.

BELANGRIJK:

Voor het opnemen van videogeluid moet u de linkse en rechtse AUDIO-INGANGEN aansluiten op de linkse en
rechtse audio-uitgangen van uw afspeelapparaat.

Voor het vastleggen van de video-opname zelf, moet u ofwel de COMPOSIETVIDEO-INGANG kiezen of de S-
VIDEO-INGANG.

1.

USB CONNECTOR - Verbind dit uiteinde van de VIDEO 2 PC met de bijgevoegde USB extensiekabel en
steek dan de extensiekabel in een vrije USB 2.0 poort van uw computer (bij voorkeur een poort aan de
achterkant).

AUDIO INPUTS - Gebruik standaard RCA-kabels om de linker- en rechter audio inputs te verbinden met
de linker- en rechter audio outputs van uw playbacktoestel. Zorg dat de juiste kleuren met elkaar worden
verbonden - rood met rood, wit met wit.

COMPOSITE VIDEO INPUT - Gebruik een standaard composiet videokabel om deze in de composite
video output van uw playbacktoestel te steken. (Indien uw playbacktoestel een S-Video output heeft, kunt u
deze kabel in de S-VIDEO INPUT steken.)

S-VIDEO INPUT - Gebruik een standaard S-videokabel (niet meegeleverd) om deze in de S-Video output
van uw playbacktoestel te steken. (Over het algemeen zijn S-Videoverbindingen van betere kwaliteit dan
de composietvideo, dus we adviseren om deze te gebruiken indien uw playbacktoestel een S-Video output
heeft.)
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LATEN WE BEGINNEN!

PowerDirector (PC)

1.

Verbind VIDEO 2 PC met uw playbacktoestel en uw
computer (zoals getoond in OVERZICHT).

Opmerking: Soms zal de software
vragen of u wilt upgraden na deze te

2. Open de PowerDirector. U zult de software vinden via: Start s d. Diti i |
Menu » Alle Programma’s » Cyberlink PowerDirector. ebben geopend. DIt Is optioneel, maar
(U kunt ook dubbelklikken op de snelkoppeling van het CEEM VEIEIEE:
bureaublad op uw computer, indien u deze tijdens de
|n§tallatle heeft gecreeerd.). . Opmerking: Voor meer gedetailleerde
3. Kiik op de “Capture” tab in de linkerhoek bovenaan het informative over de PowerDirector, druk
scherm. De software zal automatische uw videotoestel op F1 van uw toetsenbord of kiik op de
waarnemen. "director's chair" icon in de linkerhoek
4. Start met opnemen door op de rode “Record” knop te bovenaan het scherm, en ga naar
klikken. Speel uw videobron af (digitale camera, TV, DVD- "Help" daarna "PowerDirector Help"
speler, etc.). voor toegang tot de hulpfunctie van de
5. Als u klaar bent met het opnemen van de video, klikt u op | Software.
“Stop”.
6. Voer de titel van uw video in bij “Captured File Name” in *Opmerking: In sommige gevallen,

het venster dat verschijnt en klik op “OK”. De video zal
verschijnen in de “Captured Content” aan de onderkant van
het venster.

e Als u een CD wilt creéren, klikt u op de “Create Disc”
tab. Gebruik de knoppen onder de “Content” tab om
videos aan uw CD toe te voegen, klik daarna op
“Burn” om de CD te branden.

afhankelijk van uw computersysteem,
kunnen de videoafbeeldingen in
PowerDirector "schokkerig" or
"stilstaand" lijken. Dit zal geen invioed
hebben op uw video; de opname zal
juist verlopen.

e Als u een video wilt bewaren in een populair formaat (zoals een portable MPEG-4 voor PSP,
iPod™, of iPhone™), klikt u op de “Edit” tab, klikt u op de “Produce” tab en selecteert u het
relevante formaat.

e Als u een video wilt uploaden naar YouTube™ of Facebook™, klikt u op de “Edit” tab, klikt u op de
"Produce" tab en daarna de "YouTube" of "Facebook" tab vlakbij de bovenkant van het venster.

iPhone en iPod zijn handelsmerken van Apple Inc., geregistreerd in de V.S. en andere landen.
YouTube is een handelsmerk van YouTube, LLC.
Facebook is een geregistreerd handelsmerk van Facebook, Inc.
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EzCAP Capture (Mac)

1.

Sluit de VIDEO 2 PC aan op uw afspeelapparaat en uw
computer (zoals getoond in het OVERZICHT). De VIDEO 2
PC moet aangesloten zijn op uw computer om de software
naar behoren op te starten.

Start EzCAP Capture. U kunt de software vinden door te
gaan naar Alle Programma's » EzCAP » EzCAP.

De eerste keer dat u EzCAP opent, wordt u gevraagd om
een serienummer in te voeren. Zoek het nummer op de hoes
van de EzCAP-cd en voer het in.

EzCAP Capture start nu op. (Opmerking: speel uw
videobron (digitale camera, televisie, DVD-speler, enz.) nog

*Opmerking: In sommige gevallen,
afhankelijk van uw computersysteem,
kunnen de videoafbeeldingen in
EzCAP ‘"schokkerig" or ‘stilstaand"
lijken. Dit zal geen invloed hebben op
uw video; de opname zal juist
verlopen. Indien dit gebeurt, adviseren
we echter om QuickTime te gebruiken
voor betere videocontrole. Zie de
onderstaande QuickTime instructies
voor meer informatie.

niet af. U moet eerst de audio-instellingen van de software

regelen.)

Klik op "Opnemen" in het bovenste menu en selecteer "Geluidsinstellingen." In het venster dat
verschijnt, klikt u op het tabblad "Bron" en kiest u "ION Audio USB 2861-apparaat" uit de lijst eronder.
Zorg er ook voor dat het menu naast "Luidspreker" op "Aan" staat. Klik op "OK" wanneer u klaar bent.
Begin op te nemen door op "Opnemen" te klikken in het bovenste menu en "Opnemen" te selecteren. * (U
kunt ook drukken op "Command"+R.) Speel uw videobron af (digitale camera, televisie, DVD-speler, enz.).
Wanneer u klaar bent met het vastleggen van uw video, klikt u in het vak in het midden van het scherm.
Klik op "OK" om terug te keren naar het hoofdscherm.

Voor meer informatie over het gebruik van EzZCAP Capture, verwijzen wij u naar de handleiding (PDF) in
de "Mac"-map op de meegeleverde cd.

Belangrijke opmerking!

Om de vastgelegde video af te spelen op uw iPod of iPhone, moet de video in een specifiek type MPEG-4
formaat worden opgeslagen, zelfs als u uw video reeds als MPEG-4 hebt opgeslagen in de software. Volg deze
stappen om uw video te converteren om op uw apparaat te worden afgespeeld:

1.

2.
3.
4

Neem uw video op, sla hem op en sluit de software.
Open de map Toepassingen.
Open QuickTime, klik op het menu "Bestand" en selecteer "Bestand openen”.

Lokaliseer de video die u zojuist hebt opgenomen en klik op 'Openen'. De video wordt geopend in
QuickTime.

Klik op het menu "Bestand" en selecteer "Opslaan als". (Indien gewenst kunt u de naam van de film
veranderen of hem opslaan op een nieuwe locatie.)

Klik op de vervolgkeuzelijst "Formatteren" en selecteer uw apparaat.
Klik op "Opslaan". Dit bestand kan nu worden afgespeeld op uw toestel.
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QuickTime (Mac)

1.

10.

11.

12.

Verbind VIDEO 2 PC met uw playbacktoestel en uw computer Opmerking: Als uw Mac op een
(zoals getoond in OVERZICHT). oudere OS (bv. 104.) werkt, zal uw
Om VIDEO 2 PC met QuickTime te kunnen gebruiken, zult u ~ QuickTime versie misschien geen
eerst uw EzCAP Capture software moeten registreren. Open recordoptie hebben of films kunnen
EzCAP Capture via Applications » EzCAP » EzCAP  bewaren. In dit geval, adviseren we
Capture. naar QuickTime Pro te upgraden om
X . . alsnog deze mogelijkheid te hebben.
U zult gevraagd worden om een serienummer bij “Serial

Number” in te voeren. U vindt het nummer op de hoes van de EzCAP CD, voer deze in en klik op “OK”.

Na het invoeren van het serienummer en de EzCAP Capture heeft zich succesvol geopend, kunt u deze
sluiten.

Indien u Snow Leopard (Mac OS X 10.6) gebruikt, stel QuickTime in om te openen in 32-bit mode alvorens
te beginnen. Dit doet u via de Applicaties map, rechterklik op "QuickTime" en selecteer "Get Info,"
controleer de "Open in 32-bit mode" vak in het verschenen venster, daarna sluit u het venster.

Open QuickTime, klik op het “File” menu en selecteer “New Movie Recording.”

Indien u een triangel in neerwaartse richting ziet, rechts van de "record" knop, klikt u hierop om een
uitrolmenu te openen. Als u geen triangel ziet, klikt u op het “QuickTime Player” menu aan de bovenkant
van het scherm en selecteert u “Preferences”.

In het uitrolmenu, zorg ervoor dat de juiste “Camera” instelling is geselecteerd (“Composite” of “S-Video",
afhankelijk van welke connector u gebruikt) en dat “USB 2861 Device” is geselecteerd als “Microphone”.
(Zorg er tevens voor dat de volumeknop aan de linkerkant van het venster omhoog staat.)

Start met opnemen door op de rode “Record” knop te klikken aan de onderkant van het scherm. Speel uw
videobron af (digitale camera, TV, DVD-speler, etc.).

Als u klaar bent met het opnemen van de video, klikt u op “Stop”. De opgenomen video zal zich
automatisch in de QuickTime player openen. Om te bewaren, ga naar “File” en selecteer “Save” (of "Save
As” om deze onder een andere naam te bewaren, maar op te slaan als een “self-contained” film).

Als u wilt dat de opgenomen video kan worden afgespeeld op uw iPhone of iPod, klik dan op
vervolgkeuzelijst "Formatteren" en selecteer uw apparaat: "iPhone (gsm)", "iPhone" of "iPod".

Klik op "Opslaan".
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